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Types and components of computer systems

• In this lecture we will cover:

• Internal Hardware
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Concepts of Hardware and Software

Hardware: is the general term for the physical components
that make up a typical computer system. For example:

Hardware falls into two categories: internal and external.
The list below are examples of external hardware, which
will be discussed in detail in Chapter 2.
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Concepts of Hardware and Software Cont.

Internal Hardware:
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Concepts of Hardware Cont.

Internal Hardware:
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Concepts of Hardware Cont.

Internal Hardware:
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Concepts of Hardware Cont.

Motherboard: The motherboard is a printed circuit board
found in all computers. It allows the processor and other
computer hardware to function and communicate with each
other.

One of the major functions of a typical motherboard is to act
as a kind of 'hub' which other computer devices connect to.
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Concepts of Hardware and Software Cont.

A typical motherboard consists of a sheet of non-conductive
material, such as hard plastic.

Thin layers of copper or aluminum are printed onto this
sheet.

These form the circuits between the various components. In
addition to circuits, a motherboard contains several sockets
and slots to connect

the other components.
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Concepts of Hardware and Software Cont.

A typical motherboard consists of a sheet of non-conductive
material, such as hard plastic.

Thin layers of copper or aluminum are printed onto this
sheet.

These form the circuits between the various components. In
addition to circuits, a motherboard contains several sockets
and slots to connect

the other components.
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Concepts of Hardware and Software Cont.

Random access memory (RAM):

• Random access memory (RAM) is an internal
chip where data is temporarily stored when
running applications.

• This memory can be written to and read from.
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Concepts of Hardware and Software Cont.

• Since its contents are lost when power to the
computer is turned off, it is often referred to as
a volatile or temporary memory.

• RAM stores the data, files or part of the
operating system currently in use.
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Concepts of Hardware and Software Cont.

Read-only memory (ROM):

• Read-only memory (ROM) is a memory used
to store information that needs to be
permanent.

• It is often used to contain, for example,
configuration data for a computer system.
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Concepts of Hardware and Software Cont.

• These chips cannot be altered and can only be
read from (hence their name).

• One of the main advantages is that the
information stored on the ROM chip is not lost
even when power is turned off to the computer.

• They are often referred to as non-volatile
memories.
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Concepts of Hardware and Software Cont.

Central processing unit (CPU)/ processor:

A central processing unit (CPU) or processor is an
electronic circuit board in a computer that can
execute instructions from a computer program.
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Concepts of Hardware and Software Cont.

The two main components are:

• Arithmetic and Logic Unit (ALU) where arithmetic
and logical operations are carried out.

• control unit (CU) which takes instructions the
decodes and executes the instructions.
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Concepts of Hardware and Software Cont.

Network interface card (NIC):

• A network interface card (NIC) is a component
that allows a computer or any other device (for
example, a printer) to be connected to a network
(for example, the internet); it can be wired or
wireless.

• Each NIC is hard-coded with a unique MAC
(media access control).
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Concepts of Hardware and Software Cont.

Types of Network interface card (NIC):
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Concepts of Hardware and Software Cont.

Graphics card:

A graphics card allows the computer to send
graphical information to a video display device such
as a monitor, television, or projector.

It usually connects to the motherboard
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Concepts of Hardware and Software Cont.

Graphics cards are usually made up of:

• a processing unit

• memory unit (usually RAM)

• a cooling mechanism (often in the form of a heat
sink since these cards generate a lot of heat)

• connections to a display unit (monitor, TV or
projector).
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Concepts of Hardware and Software Cont.

Graphics cards are
usually made up of:

•
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Concepts of Hardware and Software Cont.

Sound card:

A sound card is an integrated circuit board that
provides a computer with the ability to produce
sounds.

These sounds can be heard by the user either
through speakers or headphones.
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Concepts of Hardware and Software Cont.

Sound cards also allow a user to record sound input
from a microphone connected to the computer, and

manipulate sound stored on a disk.
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Concepts of Hardware and Software Cont.

Internal hard disk drive/ solid-state drive
(HDD/SSD):

Basically, hard disk drives (HDDs) are magnetic in
nature and are one of the main methods for storing
data, files (text, photos and music) and most of the
system and applications software.
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Concepts of Hardware and Software Cont.

Internal hard disk drive/ solid-state drive
(HDD/SSD):

More modern computers (and all tablets) use the
newer storage systems which make use of solid-state
(SSD) technology and are replacing HDDs in many
cases. Their function is the same as an HDD.



Page  25

Concepts of Hardware and Software Cont.

Internal hard disk drive/ solid-state drive
(HDD/SSD):
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Concepts of Hardware and Software Cont.

Software:

is the general term used for the programs that
control the computer system and process data.

The software considered in this course falls into
two categories: applications and system.
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Concepts of Hardware and Software Cont.

Applications software:

provides the services that the user requires to solve a

given task. For example:
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Concepts of Hardware and Software Cont.

Applications software:
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Concepts of Hardware and Software Cont.
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Concepts of Hardware and Software Cont.
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Concepts of Hardware and Software Cont.
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Concepts of Hardware and Software Cont.

System software is the software designed to

provide a platform on which all other software

can run. For example:
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Concepts of Hardware and Software Cont.

System software is the software designed to

provide a platform on which all other software

can run. For example:
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Concepts of Hardware and Software Cont.
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Concepts of Hardware and Software Cont.
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What Makes Up a Computer?

Computers: A combination of hardware and
software.

Understanding components is key for
troubleshooting and optimization.
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What Makes Up a Computer?

Topics Covered:

1. Computer Portions 2. Hardware Parts

3. Input/Output (I/O) Units 4. Memory Types

5. CPU Components 6. Computer Ports

7. Personal Computers (Features and Types)
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Computer Portions

• Input: Devices for data entry (e.g., keyboard,
mouse).

• Processing: Central Processing Unit (CPU) –
'Brain of the computer.'
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Computer Portions

• Storage: Hard drives, SSDs, and RAM.

• Output: Devices like monitors and printers.

• Power Supply: Converts electricity to power the
components.
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Essential Hardware Components

Motherboard: Main circuit board connecting all 
parts.

CPU: Core processor for executing instructions.

RAM: Temporary memory for running processes.

Storage:

- HDD: Mechanical storage.

- SSD: Faster, solid-state storage.
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Essential Hardware Components

Power Supply Unit (PSU): Provides electricity to 
components.

Graphics Processing Unit (GPU): Specialized for 
visual tasks.
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Input and Output Units

• Input devices are hardware that allows data to 
be entered into a computer.

• They use either manual entry (such as a 
keyboard or a mouse) or direct data entry (such 
as sensors or optical character readers). 
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Input and Output Units

• Essentially, these devices turn input into a form 
the computer can understand for example, a 
mouse turns hand movements into cursor 
movements on the screen. 

• Sometimes the data has to go through an 
Analogue To Digital Converter (ADC) before 
the computer can make any sense of it.
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Input and Output Units

Note:

• Some devices can act as both input and output. 
For example, a touch screen can do both, as can 
a DVD writer/player; but most devices are only 
capable of either inputting data into a computer 
or displaying the results of computer processing 
(output device).
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Input and Output Units

Input devices and their uses:

Keyboards: 

• Keyboards are by far the most common method 
used for data entry. 

• They are used as the input device on computers, 
tablets, mobile phones and many other 
electronic items.
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Input and Output Units

Keyboards:

• The keyboard is connected to the computer 
through a USB or wireless connection. 

• In the case of tablets and mobile phones, the 
keyboard is often virtual or a type of 
touchscreen technology (see later).
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Input and Output Units

Keyboards:

• When the character on the keyboard is pressed, 
it is converted into a digital signal, which the 
computer interprets.

• They are a relatively slow method of data entry 
and are also prone to errors.
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Input and Output Units

Keyboards:

• But keyboards are probably still the easiest way 
to enter text into a computer.

• However, frequent use of these devices can lead 
to injuries, such as repetitive strain injury (RSI) 
in the hands and wrists.
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Input and Output Units

Keyboards:
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Input and Output Units

Keyboards:

Ergonomic keyboards can help to overcome this

problem - these have the keys arranged differently,

as shown.

They are also designed to give more support to the 
wrists and hands when doing a lot of typing.
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Input and Output Units

Keyboards:

Ergonomic keyboard
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Input and Output Units

Uses of keyboards

» Input of data into applications software (for 
example, text into word processors, numbers into 
spreadsheets, and so on).

» Typing in commands to the computer (for 
example, Prnt Scrn, CtrI+P to print out, and so on).
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Advantages of and Disadvantages of keyboards

Advantages of keyboards Disadvantages of keyboards

Fast entry of new text into a document. Can be difficult to use if the user has limited

arm/wrist use.

Well-known method. Slow method when compared to direct data

entry (for example, Optical Mark

Recognition).

Easy to use for most people. Fairly large device that uses up valuable desk

space.

Easier to do verification checks as data is

entered (can immediately compare the source

document with typed data on the screen).
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Input and Output Units

Pointing devices:

Mouse: 

• The mouse is an example of a pointing device.

• The user controls the position of a pointer on 
the screen by moving the mouse around. 
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Input and Output Units

Pointing devices:

Mouse: 

• There are usually two buttons which have 
different functions; the left button is used to 
select items by double clicking, while the right 
button brings up drop-down menus.
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Input and Output Units

Pointing devices:
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Input and Output Units

Pointing devices:
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Input and Output Units

Pointing devices:

Mouse:                                        Arc Mouse: 
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Input and Output Units

Pointing devices:

Mouse:

Many also have a scroll button, which speeds up 
the process of moving through a document.
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Input and Output Units

Mouse:

• The optical mouse (where movement is detected 
by reflected light rather than the position of a 
moving ball) and the cordless or wireless mouse 
(which transmits signals to a USB wireless 
receiver plugged into the computer) are in use 
on modern computers. 
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Input and Output Units

Mouse:

The advantage of an optical mouse is it has no 
moving parts and it also does not pick up any dirt. 
This makes it more robust and improves its 
performance because the older type of mouse can 
'skid’ on certain surfaces reducing the control of 
the pointer.
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Input and Output Units

Uses of a mouse

Almost anything, depending on the software, but 
includes:

» grouping sing and eliting fileftware

» image editing, for example, controlling the size 
and position of a drawing pasted into a document
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Input and Output Units

» controlling the position of a pointer on the screen 
to allow selection from a menu or selecting an 
icon, and for scrolling up and down/left and right.
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Input and Output Units

» controlling the position of a pointer on the screen 
to allow selection from a menu or selecting an 
icon, and for scrolling up and down/left and right.
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Input and Output Units

» controlling the position of a pointer on the screen 
to allow selection from a menu or selecting an 
icon, and for scrolling up and down/left and right.

Touchpad:
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Input and Output Units

Touchpad:

Use of a touchpad

Their uses are the same as those of a mouse.
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Input and Output Units

Touchpad:
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Input and Output Units

Joysticks:

• Joysticks have similar functions to a mouse and 
a tracker ball. 

• By gripping the stick, a pointer on the screen 
can be controlled. 
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Input and Output Units

Joysticks:

• Buttons are used to make selections. 

• Often they have another button on the top of the 
stick that is used for gaming purposes for 
example to fire a weapon.
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Input and Output Units

Uses of a joystick

» Used in video/computer games.

» Used in simulators (for example, flight 
simulators) to mimic actual controls.
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Input and Output Units

Uses of a joystick

» Used in video/computer games.

» Used in simulators (for example, flight 
simulators) to mimic actual controls.
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Input and Output Units

Touch screens (as an input device):

With a touch screen the user can choose an option 
by simply touching a button/icon on the screen. 
The selection is automatically made without the 
need for any pointing device.
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Input and Output Units

Touch screens (as an input device):

Uses of touch screens:

» Self-service tills, for example, petrol stations, 
where the user just touches the screen to select the 
fuel grade and payment method.
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Input and Output Units

» Automatic teller machines (ATMs) to choose 
from on-screen options.

» Point of sale terminals such as in restaurants.

» Public information systems at airports, railway 
stations, tourist offices, etc.

» Mobile phones, tablets and satellite navigation 
systems.
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Input and Output Units

» Interactive white boards in education.

» Computer-based training (CBT) where answers 
are selected during on-screen testing.

» They can obviously also be used as an output 
device because they also work as a flat-screen 
monitor.
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Input and Output Units
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Input and Output Units

» Interactive white boards in education.

» Computer-based training (CBT) where answers 
are selected during on-screen testing.

» They can obviously also be used as an output 
device because they also work as a flat-screen 
monitor.
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Input and Output Units

Scanners:

Scanners are used to enter information from hard 
copy (for example, text documents, photographs) 
into a computer. The most common type is the 
flatbed scanner, which is made up of a glass panel 
and lid. The hard copy document or photo is 
scanned by a light source and produces a 
computer-readable image.
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Input and Output Units

Scanners: barcode scanners.
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Input and Output Units

• The subsequent image can then be manipulated using 
a drawing package. 

• Images of text can also be used with optical character 
recognition (OCR) software to produce editable text 
documents.

• There are also specialist scanners which are designed 
to carry out a specific task, for example, barcode 
scanners.
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Input and Output Units

Uses of scanners:
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Input and Output Units

Uses of scanners:
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Input and Output Units

Microphones:

Microphones are either built into the computer or are 
external devices connected through the USB port or 
using Bluetooth connectivity. The Figure below shows 
how a microphone can convert sound waves into an 
electric current. 
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Input and Output Units

Microphones:

The current produced is converted to a digital format so 
that a computer can process it or store it (for example, 
on a CD).
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Input and Output Units

» When sound is created, it causes the air to vibrate.

» When a diaphragm in the microphone picks up the air 
vibrations, the diaphragm also begins to vibrate.

» A copper coil is surrounded by a permanent magnet 
and the coil is connected to the diaphragm using a cone. 
As the diaphragm vibrates, the cone moves in and out 
causing the copper coil to move backwards and 
forwards relative to the magnet.
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Input and Output Units

» This forwards and backwards motion cuts through the 
magnetic field around

the permanent magnet, inducing an electric current.

» The electric current is then either amplified or sent to 
a recording device. The electric current is analogue in 
nature.
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Input and Output Units

The electric current output from the microphone can 
also be sent to a computer where a sound card converts 
the current into a digital signal which can then be stored 
in the computer.
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Input and Output Units

The electric current output from the microphone can 
also be sent to a computer where a sound card converts 
the current into a digital signal which can then be stored 
in the computer.
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Input and Output Units

The electric current output from the microphone can 
also be sent to a computer where a sound card converts 
the current into a digital signal which can then be stored 
in the computer.



Page  56

Input and Output Units

Other Input Deices:

Sensors

Card readers

Chip and PIN readers

Radio frequency identification (RFID) readers

Optical mark recognition/reader (OMR)

Optical character recognition/reader (OCR)
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Concepts of Hardware and Software Cont.

END Of Part 1 Lecture
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What Makes Up a Computer?

Computers: A combination of hardware and
software.

Understanding components is key for
troubleshooting and optimization.
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What Makes Up a Computer?

Topics Covered:

3. Input/Output (I/O) Units

Cont.

4. Memory Types

5. CPU Components 6. Computer Ports

7. Personal Computers (Features and Types)
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Input and Output Units

Output devices and their uses:

As the name suggests, these are devices that 
usually show the result of computer processing in 
a format that can be understood by a human (for 
example, on a monitor or printed on paper). 
However, some output devices are part of a control

system. 
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Input and Output Units

Output devices and their uses:

In these examples, the computer is controlling a 
process and sends signals to these output devices.
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Input and Output Units

Output devices and their uses:

Monitors: we will consider two types of monitor:

» the cathode ray tube (CRT) monitor.

» LCD (or TFT) screen (TFT means 'thin film 
technology'; a general term for modern thin 
screens).
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Input and Output Units

• While CRT monitors have just about been 
phased out everywhere, they are included here 
because these are the only type of device which 
allows the use of light pens (see Section 2.1.11). 

• Consequently, some companies using CAD still 
use large CRT monitors to enable the use of 
light pens as part of the drawing environment.
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Input and Output Units

CRT monitors

• Cathode ray tube (CRT) monitors are the least 
expensive type of monitor, although they are 
becoming increasingly rare as LCD monitors are 
now taking over. 

• They come in various sizes and make use of an 
electron gun firing against a phosphor screen. 
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Input and Output Units

CRT monitors

• The picture is made up of tiny dots which are 
colored red, green or blue.

• The intensity of each colored dot makes up the 
vast range of colors interpreted by the eye.
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Input and Output Units

Uses of CRT monitors

» They are only used in specialist areas, such as 
computer-aided design (CAD); the screens are 
usually very large to enable complex diagrams to 
be created or modified.

» They are used with light pens to allow designs to 
be created on screen.
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Input and Output Units

Uses of CRT monitors
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Input and Output Units

Uses of CRT monitors
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Input and Output Units

LED and LCD screens:

LED screens:

• An LED screen is made up of tiny light emitting 
diodes (LEDs). Each LED is either red, green or 
blue in color. 
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Input and Output Units

• By varying the electric current sent to each 
LED, its brightness can be controlled, producing 
a vast range of colors.

• This type of screen tends to be used for large 
outdoor displays, due to the brilliance of the 
colors produced. Recent advances in LED 
technology have led to the introduction of 
OLED (organic LED) screens.
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Input and Output Units

• Note: Many monitors and television screens are 
advertised as LED when in fact they are LCD 
screens which are backlit using LEDs.
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LCD screens

• LCD screens are made up of tiny liquid crystals. 
These tiny crystals make up an array of pixels 
which are affected by changes in applied electric 
fields. 

• How this works is outside the scope of our 
course, but the important thing to realise is that 
for LCD screens to work, they require some 
form of backlighting.
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LCD screens

• Modern LCD screens are backlit using light 
emitting diode (LED) technology and must not 
be confused with pure LED screens. 

• When LEDs are used, a matrix of tiny blue-
white LEDs is used behind the LCD screen. 

• The use of LED backlighting gives a very good 
contrast and brightness range.
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LCD screens

• Before the use of LEDs, LCD screens used Cold 
Cathode Fluorescent Lamps (CCFL) as the back 
lighting method. Essentially, CCFL used two 
fluorescent tubes behind the LCD screen to 
supply the light source.
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LCD screens

• Before the use of LEDs, LCD screens used cold 
cathode fluorescent lamps (CCFL) as the back 
lighting method. Essentially, CCFL used two 
fluorescent tubes behind the LCD screen to 
supply the light source.
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LCD screens

• Why are LEDs more popular than 
CCFLs for backlighting? Or

• Why are LEDs preferred over CCFLs 
for backlighting applications?
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LCD screens

• Solution: LEDs are preferred over 
CCFLs because they are more energy-
efficient, provide better brightness, 
enable thinner designs, and have a 
longer lifespan.
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LCD screens

• What are the advantages of LED 
technology over CCFL technology in 
backlighting applications?
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LCD screens

• Solution: 
1. Energy Efficiency: LEDs consume

significantly less power compared to CCFLs,
making them more eco-friendly and cost-
effective.

2. Slimmer Design: LEDs are compact, enabling
thinner and lighter displays.
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LCD screens

• Solution: 
3. Longer Lifespan: LEDs have a longer
operational life, reducing the need for frequent
replacements.

4. Better Brightness and Contrast: LEDs provide
higher brightness levels and improved contrast
ratios, enhancing display quality.
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LCD screens

• Solution: 
5. Faster Response Time: LEDs can be turned on
and off more quickly, enabling better performance
in dynamic visual applications.

6. Environmental Friendliness: LEDs do not
contain mercury, unlike CCFLs, making them
safer for the environment.
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LCD screens
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LCD screens
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Touch screen (as an output device)

A touchscreen, while primarily considered an

input device, can also serve as an output device

in certain contexts. This dual functionality

makes it unique compared to many traditional

devices. Here's how a touchscreen works as an

output device:
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Output Functionality of 
Touchscreens

Display Visual Information:

• Touchscreens are often integrated with

display technologies like LCD, LED, or

OLED. These screens show text, images,

videos, and graphical interfaces, fulfilling the

output function of visual representation.
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Output Functionality of 
Touchscreens
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Output Functionality of 
Touchscreens
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Multimedia projectors

• Multimedia projectors receive signals that

can be either analogue or digital (although

most modern projectors only work with

digital inputs).

• The signal source is usually from a

computer, television or DVD player.
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Multimedia projectors

• The image from the source is magnified and

projected onto a large screen.

• The devices work with a remote control

which acts like a cordless mouse when

interfacing with the screen.
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Multimedia projectors

• The image from the source is magnified and

projected onto a large screen.

• The devices work with a remote control

which acts like a cordless mouse when

interfacing with the screen.
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Multimedia projectors

• It is then possible to direct the computer

presentation without being tied to the

computer (another feature of the virtual

mouse is the laser pointer).

• Most multimedia projectors take input from

various types of video format.
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Multimedia projectors
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Multimedia projectors
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Multimedia projectors
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Printers

This section will consider the use of the three

most common types of printer:

» laser printer

» inkjet printer

» dot matrix printer.



Page  40

Printers

This section will consider the use of the three

most common types of printer:

» laser printer

» inkjet printer

» dot matrix printer.
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Printers

Laser Printer:

• Produce very high-quality hard copy output.

• The print rate per page is very quick if a large

number of pages are being printed.

• They rely on large buffer memories where the

data for the whole document is stored before

pages can be printed out.
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Printers

How Laser Printer print out a page?

The laser printing process begins with a

positively charged drum. A laser removes the

charge in specific areas, creating a pattern

matching the text or image. Positively charged

toner adheres to these negatively charged areas.
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Printers

A negatively charged sheet of paper rolls over the

drum, picking up the toner. The paper’s charge is

neutralized to prevent sticking, and it passes

through heated rollers (fuser) to melt and fix the

toner permanently. Finally, a discharge lamp

resets the drum for the next print.
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Printers
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Printers

There are six steps in the process of a laser printer.

They are:-

1. Cleaning

2. Conditioning

3. Writing

4. Developing

5. Transfer

6. Fusing.
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Printers

There are six steps in the process of a laser printer.

They are:-

1. Cleaning

2. Conditioning

3. Writing

4. Developing

5. Transfer

6. Fusing.
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Printers

Advantages of inkjet printers

» High-quality output.

» Cheaper to buy than laser printers.

» Very lightweight and have a small physical footprint.

» Do not produce ozone and volatile organic compounds,

unlike laser printers.
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Printers

Disadvantages of inkjet printers

» Slow output if several copies are needed (little buffer capacity to

store the pages).

» Cannot do large print jobs (ink cartridges run out too quickly).

» Printing can 'smudge' if the user is not careful.

» Can be expensive if used a lot (original ink cartridges are

expensive to buy).
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Concepts of Hardware and Software Cont.

END Of Part 2 Lecture
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Topics Covered:

This lecture covers three essential components
of computer systems:

- Memory Types

- CPU Components

- Computer Ports
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Memory Types: Definition and
Categories

Definition and Importance

• Memory in a computer system refers to the
physical devices used to store data or
instructions temporarily or permanently.

• It is crucial because it directly affects the
performance and capacity of a computer to
execute tasks efficiently.
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Memory Hierarchy

Memory organized by speed, cost, and size:

- Registers: Fastest, smallest capacity

- Cache Memory

- RAM: Main memory

- Secondary Storage: HDD, SSD

- Tertiary Storage: USB, Cloud
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Memory Hierarchy
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Memory Categories

1. Primary Memory (RAM, Registers, Cache)

- Volatile, high-speed.

2. Secondary Memory (HDD, SSD)

- Non-volatile, permanent storage.

3. Tertiary Memory (USB, Cloud Storage)

- Backup and portable storage.
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Memory Categories

1. Primary Memory (Volatile):

Random Access Memory (RAM):

•Temporary storage used to hold data and
instructions currently in use. Volatile memory
(data is lost when power is off)

•Used for temporary storage of data and
instructions
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Memory Categories

•Faster than secondary storage.

•Types of RAM:

•Static RAM (SRAM): Faster and more
expensive, used in cache memory.

•Dynamic RAM (DRAM): Slower and less
expensive, used in main memory.
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Memory Categories

•ROM (Read-Only Memory):

•Non-volatile memory (data persists even when
power is off)

•Stores firmware and boot instructions

•Cannot be modified easily
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Memory Categories

•Registers:

•Small, high-speed storage areas within the
CPU.

•Store immediate data for processing.
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Memory Categories

•Cache Memory:

•Cache memory, also called CPU memory, is
high-speed memory that a CPU can access
more quickly than it can access regular random
access memory (RAM).

•This memory is typically integrated directly
into the CPU chip.
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Memory Categories

•The purpose of cache memory is to store
program instructions and data that are used
repeatedly in the operation of programs or
information that the CPU is likely to need next.
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Memory Categories

• Cache Memory:

•A small, fast memory
located inside or
close to the CPU.

•Reduces latency by
storing frequently
accessed data.
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Memory Categories

2. Secondary Memory (Non-Volatile):

Used for permanent data storage.

Examples:

•Hard Disk Drives (HDD): Magnetic storage
devices with large capacities but slower speeds.

•Solid State Drives (SSD): Faster, more durable
storage using flash memory.
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Memory Categories

3. Tertiary/External Memory:

•Used for data backup and portability.

•Examples:

•USB drives, optical discs (CDs/DVDs), and
cloud storage.
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Memory Categories

3. Comparison of Memory Types



Page  17

CPU Components: Overview

The CPU is the 'brain' of the computer. Key
components:

- Control Unit (CU): Directs data flow

Directs the flow of data and instructions between the
CPU, memory, and input/output devices.

Responsible for fetching, decoding, and executing
instructions.

-
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CPU Components: Overview

- Arithmetic Logic Unit (ALU):

- Performs calculations (addition, subtraction,
etc.) and logical operations (AND, OR, NOT,
etc.).

- Registers: Temporary data storage

- Cache Memory: Speeds up data access
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CPU Components: Overview

- Registers:

• Small, high-speed storage areas inside the
CPU.

• Temporarily store data, instructions, or
intermediate results.
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CPU Components: Overview

- Cache Memory: Speeds up data access.

- How?

- (Stores frequently accessed instructions and
data to speed up processing).
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CPU Instruction Cycle

The CPU processes instructions in cycles:

1. Fetch: Retrieve instruction from memory

2. Decode: Interpret instruction

3. Execute: Perform the operation

4. Store: Save the result back to memory or
registers
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CPU Instruction Cycle 
Advanced CPUs:

Modern CPUs feature advanced technologies:

•Multi-core Processors:

•Contain multiple cores to perform parallel
processing.

•Graphics Processing Units (GPUs):

•Specialized processors for handling graphics
and complex mathematical computations.
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Computer Ports: Overview 

Ports are physical interfaces for connecting
external devices.

Common Types:

- Input: USB, HDMI, VGA, Ethernet

- Output: HDMI, Audio Jacks, DisplayPort

- Specialized: Thunderbolt, eSATA, FireWire
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Computer Ports: Input Ports

 USB (Universal Serial Bus):

•Most common port for connecting peripherals
like keyboards, mice, and external drives.

 HDMI (High-Definition Multimedia Interface):

•Transfers audio and video to external displays
or monitors.
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Computer Ports: Input Ports

 VGA (Video Graphics Array):

•Analog video port used for older monitors.

 PS/2:

•Used for older keyboards and mice.

 Ethernet:

•For wired internet connections.
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Computer Ports: Output Ports

•HDMI: Supports both input and output in
modern devices.

•Audio Jacks: Used for headphones, speakers, or
microphones.

•DisplayPort: For high-definition video output.
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Computer Ports: Specialized Ports 

• Thunderbolt: High-speed data transfer and
display connectivity.

• FireWire (IEEE 1394): Used in older systems
for high-speed data transfer.

• eSATA: For connecting external storage
devices.
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Computer Ports:

Common Use Cases

• USB for charging and data transfer.

• HDMI for connecting to external monitors.

• Ethernet for stable internet connections in
offices.
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Integration of Components
:

To understand how memory, CPU, and ports work
together:

1.A file stored on an external USB drive (port).

2.The file is loaded into RAM (memory).

3.The CPU processes the file, using cache and registers
for intermediate data.

4.The processed file is saved back to the external drive
or displayed on a monitor.
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Conclusion

- Memory: Stores and accesses data.

- CPU: Processes and executes instructions.

- Ports: Enable communication with external
devices.

Understanding these fundamentals is key to
optimizing computer systems.
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Concepts of Hardware and Software Cont.

END Of Lecture
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Topics Covered:

• OS
• Functions of an OS
• Types of Operating Systems
• Graphical User Interface (GUI) Basics
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Operating Systems and 
Graphical User Interfaces

Definition
• An Operating System (OS) is software that 

manages a computer's hardware and software, 
allowing users and applications to interact with 
the system. It controls resources like the CPU, 
memory, and storage, making the computer easy 
to use.
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Operating Systems and 
Graphical User Interfaces

Is An Operating System Considered Software?
An Operating System (OS) is system software that 
acts as a bridge between computer hardware and 
users, managing hardware resources and
supporting software programs. 
Examples include Windows, macOS, Linux, 
Android, and iOS/iPadOS.
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Operating Systems and 
Graphical User Interfaces

OR:
What is an Operating System (OS)?
An OS is: system software that manages computer 
hardware and software resources.
The operating system (OS) controls almost all 
functions on a computer.
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Desktop OS Mobile OS Server OS Real-Time OS

Windows, 
macOS, Linux 

(Ubuntu, 
Fedora).

Android 
(Google), 
iOS/iPad OS 
(Apple), 

HarmonyOS 
NEXT 

(Huawei).

Windows 
Server, Linux 

Server.

Used in 
embedded 

systems like 
robotics and IoT 

devices.
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Functions of an OS:
There are 5 functions of operating system.
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Functions of an OS:
There are 5 main functions of operating system.
1. Input / Output Management
2. Process Management
3. Memory Management
4. File Management
5. Administration Management
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Functions of an OS:
There are 5 functions of operating system.
1. Input / Output Management
• Operating system coordinates with different 

input / output device.
• Operating System manages the input and output 

of all programs running under its control.
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Functions of an OS:
There are 5 functions of operating system.
2. Process Management
• Operating system manages the process which is 

processed one by one by the C.P.U. ( Central 
Processing Unit) . 
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Functions of an OS:
• This management is again done by the 

Operating system and it is proportionally 
rationed out by the O.S. to enable each process 
or program to run properly.
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Functions of an OS:
3. Memory Management
Operating System manage the memory were, the 
program is stored for future use.
4. File Management
The operating system manages all the files on the 
computer across different drives or locations. 
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Functions of an OS:
• It keeps track of the memory addresses where 

files are stored, allowing you to access them in 
the future. This ensures efficient storage, 
retrieval, and organization of files whenever 
needed.
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Functions of an OS:
5. Administration Management
An operating system's administration management 
handles the overall administration of the computer. This 
includes managing users, resources, software, security, 
and network configurations to ensure the system 
operates efficiently and securely.
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Types of Operating Systems:

Operating System can be classified into major parts.
1. According to User based
2. According to Interface based
According to user based:- In the classification 
Operating System is studied according to the capacity 
of serving user.
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Types of Operating Systems:

According to user Operating System can be classified 
into two parts:-
1. Single user
In single user Operating System only one user can work 
at a time on computer. This Operating System is widely 
used with personal computer installed in home, office 
etc.
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Types of Operating Systems:

2. Multi user
In Multi user Operating System more than one user can 
work on computer at a time, so, we called it Multi-
tasking. For (e,g. Linux, UNIX).
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Types of Operating Systems:

According to Interface based There are two types of 
Operating System.

Graphical User Interface
(GUI): The user interacts
with menus and icons.

Command Line Interface
(CLI): The user types
commands at a prompt.
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Types of Operating Systems:
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Graphical User Interface (GUI) 
Basics

GUI allows interaction with devices using graphical 
elements like windows and icons.
• Characteristics:
  - Visual Representation: Windows, icons, menus, and 
pointers.
  - Interactive Elements: Drag-and-drop, clickable buttons.
  - Ease of Use: No need for command-line knowledge.
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Common GUI Components
Desktop: Main workspace with icons and shortcuts.
• Taskbar/Status Bar: Displays active programs, 
notifications, and system status.
• Windows: Title bar, menu bar, minimize/maximize 
buttons.
• Icons: Files, folders, shortcuts, apps.
• Menus: Dropdowns for options and commands.
• Toolbars: Quick access to frequently used tools.
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User Interface Across Common Operating 
Systems

• Windows:
  - Features: Start menu, taskbar, file explorer.
  - Tools: Snipping Tool, Task Manager.
• macOS:
  - Features: Dock, Finder, Spotlight search.
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User Interface Across Common Operating 
Systems

Linux:
  - Highly customizable GUIs (e.g., GNOME, KDE).
• Mobile OS (Android/iOS): Touch-based interface, 

app stores.
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Mouse Techniques in GUI
• Clicking: Left-click to select, right-click for 

context menus.
• Double-clicking: Open files or execute programs.
• Dragging: Click and hold to move items.
• Scrolling: Use the scroll wheel to navigate pages.
• Hovering: Move the pointer over an item to see a 

preview or tooltip.
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Icons and Their Use
• Types of Icons:
  - Application Icons: Launch programs.
  - File Icons: Represent documents.
  - Folder Icons: Store files and subfolders.
  - Shortcut Icons: Links to files, programs, or web 
pages.
•



Page  26

Icons and Their Use
Interacting with Icons:
  - Single-click: Select.
  - Double-click: Open.
  - Drag-and-drop: Move or copy files.
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Status Bar
• Location: Typically, at the bottom of the 

window or desktop.
• Displays:
  - Current application status.
  - Notifications (e.g., battery, updates).
  - Real-time information (e.g., page numbers, 
zoom levels).
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Benefits of GUI over CLI
• Ease of Use: Intuitive for beginners.
• Visual Representation: Easier to understand.
• Multitasking: Switch between multiple windows 

easily.
• Accessibility: Supports touchscreens and other 

input methods.
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Recap and Conclusion
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Roles of an Operating System

• All computers rely on an 
operating system (OS) to 
provide the interface for 
interaction between users, 
applications, and hardware.

• Almost all modern operating 
systems can support more 
than one user, task, or CPU.
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Roles of an Operating System
• Control hardware access
 OS automatically discovers and configures  

PnP (Plug and Play) hardware.
• File and folder management
• User interface
 Command line interface (CLI)
 Graphical user interface (GUI)
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Roles of an Operating System
• Application management
 Open Graphics Library 

(OpenGL)
 DirectX
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Conclusion
• OS is the backbone of computing devices.
• GUI makes interaction intuitive and efficient.
• Understanding basic OS and GUI features 

enhances productivity.
Questions?
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Concepts of Hardware and Software Cont.

END Of Lecture
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Topics Covered:

• Use of Common Icons.

• The Status Bar.

• Using Menus and Menu Selection.

• Concept of Folders and Directories.

• Opening and Closing Different Windows

• Creating Shortcuts



Page  3

Use of Common Icons

• Icons are small pictures that represent files,
folders, programs, and other items.

• When you first start Windows, you'll see at least
one icon on your desktop: the Recycle Bin (more
on that later).

• Your computer manufacturer might have added
other icons to the desktop.
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Use of Common Icons

• Double-clicking a desktop icon starts or opens the
item it represents. For example, double-clicking
the Internet Explorer icon starts Internet Explorer.
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Use of Common Icons

From the icon shape we could conclude many things 
about it’s type and it’s work.

: is a folder (place where files and folders 
stored).

:is the My Computer icon which store all 
drives inside the computer



Page  6

Use of Common Icons

:is the Recycle Bin icon A temporary storage place   
for deleted files. You can use it to retrieve files 
deleted in error.

:is a word file icon.

:is a power point file icon. 

: are shortcut icons



Page  7

Use of Common Icons

:is the Recycle Bin icon A temporary storage place  
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The Status Bar

• Definition: A thin strip at the bottom of an
application window displaying status
information.

Features:

- Displays details such as current page, zoom level,
or unsaved changes.

- Often includes shortcuts to additional settings.
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The Status Bar MacOS Version
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The Status Bar MacOS Version

A. Slide

This displays the active slide number, as well as
the number of slides in the open presentation.

B. Theme name

Here you can see the Theme that's been applied to
the open presentation.
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The Status Bar MacOS Version

C. Language

This displays the language specified.

D. Notes

This is a toggle button to open or close the Notes
pane.
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The Status Bar MacOS Version

E. Comments

This again is a toggle button that opens and closes
the Comments Task pane.
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The Status Bar MacOS Version

F. View Buttons

Here you can select appropriate buttons to switch
to Normal, Slide Sorter, or Slide Show views
(highlighted in red within). (Shift + click the same
buttons to access Slide Master view, Handout
Master view, and the Set Up Show dialog box.
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The Status Bar MacOS Version

F. View Buttons

Here you can select appropriate buttons to switch
to Normal, Slide Sorter, or Slide Show views
(highlighted in red). (Shift + click the same
buttons to access Slide Master view, Handout
Master view, and the Set Up Show dialog box.
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The Status Bar MacOS Version

G. Zoom

There are three options to zoom-in or zoom-out the
slide as shown highlighted in blue above.

Pull the slider left or right, or click the plus or
minus sign to zoom in or out.
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The Status Bar MacOS Version

You can also click the zoom
percentage level value to bring up
the Zoom dialog box as shown in
Figure 3; here you can specify the
zoom level.
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The Status Bar MacOS Version

H. Fit slide to current window

Click this button to fit the slide in the available
Slide Area.



Page  18

The Status Bar MacOS Version

You can customize what appears
on the Status Bar by right-
clicking (or CtrI) + clicking).
Then, select or deselect options in
the resultant Customize Status
Bar menu, that you can see in
Figure 4.
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The Status Bar in Windows OS
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The Status Bar in Windows OS

A. Slide Number

This displays the active slide number, as well as
the number of slides in the open presentation.

B. Spell check

This sign indicates that spell check is enabled in
the presentation.
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The Status Bar in Windows OS

This sign has two different appearances:

Open book with red X: This sign indicates, that
the spell check has finished, and spelling error
are found.

The spelling error is underlined with a red
squiggly line.
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The Status Bar in Windows OS

C. Notes

This is a toggle button to open or close the
Notes Pane. Similar to D in the MacOS version.

D. View Shortcuts

Similar to F in the MacOS version.
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The Status Bar in Windows OS

E. Zoom Slider

Pull the slider left or right to zoom in or out.

F. Zoom level

Click the zoom level to bring up the Zoom
dialog box as shown, here you can specify the
zoom level.
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The Status Bar in Windows OS

E. Zoom Slider

Pull the slider left or right to zoom in or
out.

F. Zoom level

Click the zoom level to bring up the
Zoom dialog box as shown, here you
can specify the zoom level.
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The Status Bar in Windows

G. Fit slide to current window

Click this button to fit the slide in the
available Slide Area.

You can customize what appears on
the Status Bar by right-clicking on it
and selecting or deselecting the check
boxes in the resultant Customize
Status Bar menu.
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The Status Bar in Windows

G. Fit slide to current window

Click this button to fit the slide in the
available Slide Area.

You can customize what appears on
the Status Bar by right-clicking on it
and selecting or deselecting the check
boxes in the resultant Customize
Status Bar menu.
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Using Menus and Menu Selection

Definition: Menus are lists of options or commands
available in software.

Types of Menus:

- Drop-down Menus: Accessed from a menu bar.

- Context Menus: Opened by right-clicking.

- Ribbon Menus: Modern graphical menus with
grouped commands (e.g., MS Office).
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Using Menus and Menu Selection

- Drop-down Menus: Accessed from a menu bar.
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Concept of Folders and Directories

Definition:

- Folder: A container for organizing files.

- Directory: The structure of folders forming a
hierarchy.

Structure:

- Parent Directory: The main folder.

- Child Directory: Subfolders within the main folder.
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Concept of Folders and Directories

Definition:
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Concept of Folders and Directories

Importance:

- Logical file organization.

- Simplifies navigation and retrieval.
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Opening and Closing Different 
Windows

- Basics:

- Opening: Double-click
a file or application icon.

- Closing: Click the 'X'
button at the top right
of the window.
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Opening and Closing Different 
Windows

Advanced Features:

- Minimize: Temporarily hide a window.

- Maximize/Restore: Adjust window size.

- Task View: View and switch between open windows.
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Creating Shortcuts

Definition: A link that provides quick access to a file,
folder, or application.

Benefits:

- Saves time.

- Reduces desktop clutter by grouping shortcuts.
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Creating Shortcuts

How to Create:

- Right-click on a file/folder >
'Create Shortcut.'

- Drag and drop the file/folder
while holding 'Ctrl + Shift.'
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Creating Shortcuts

How to Create:

- Right-click on a file/folder >
'Create Shortcut.'

- Drag and drop the file/folder
while holding 'Ctrl + Shift.'
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Creating Shortcuts

How to Create:

- Right-click on a file/folder >
'Create Shortcut.'

- Drag and drop the file/folder
while holding 'Ctrl + Shift.'
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Conclusion

Recap of the topics covered:

- Common icons.

- Status bar functionality.

- Menus and their types.

- Folders and directory structure.

- Managing and creating shortcuts.

Key Takeaway: Mastering GUI

elements enhances efficiency

and user experience.
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END Of Lecture
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Topics Covered:

• Introduction to Microsoft Word.

• Starting Microsoft Word.

• The Word Interface.

• Creating and Managing Documents.

• Text Creation and Editing.

• Formatting Text and Paragraphs.

• Using Templates

• Customizing the Ribbon
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Introduction to Microsoft Word

What is Microsoft Word?

- A widely used word processor designed by Microsoft.

- Part of the Microsoft Office Suite but can also be a
stand-alone application.

- Initially launched in 1983, now available for
Windows and macOS.

• Microsoft Word is often called simply Word or MS
Word.
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Starting Microsoft Word

Launching Microsoft Word

- Steps:

1. Click the Start button in Windows.

2. Select "Microsoft Word" from the menu.
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Starting Microsoft Word

Options:

- Open a blank document.

- Choose a template.

- Open a recent document.

- Tip: Pin the Microsoft Word

icon to the taskbar for quicker access.



Page  6

Starting Microsoft Word
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The Word Interface

Microsoft Word Interface Overview

- Ribbon: Divided into Tabs, Groups, and
Commands for efficient navigation.

- Quick Access Toolbar: Shortcut storage for
frequently used features.

- Cursor Behavior: Changes based on interaction
(e.g., arrow, I-beam).
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The Word Interface
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The Word Interface
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The Word Interface



Page  11

Creating and Managing Documents

Working with Documents

- Creating Documents:

- Open a blank document or select a template.

- Opening Existing Documents:

- File > Open > Browse for files.
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Creating and Managing Documents

Working with Documents
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Creating and Managing Documents

- Saving Documents:

- File > Save As, choose location, name, and
format.

- Shortcut: Ctrl+S.

- Printing:

- File > Print, customize settings, and print.
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Text Creation and Editing

- Adding and Editing Text

- Adding Text:

- Type directly in the document. Text
automatically wraps to the next line.

Editing Text:

- Insert or delete text using the cursor.

- Use Backspace or Delete keys.
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Text Creation and Editing

- Selecting Text:

- Highlight using the mouse or Ctrl+A for all
text.

- Undo/Redo:

- Undo (Ctrl+Z), Redo (Ctrl+Y).
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Text Creation and Editing
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Formatting Text and Paragraphs
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Formatting Text and Paragraphs

- Formatting Essentials

- Font Styles:

- Change font type, size, and color.

- Apply bold, italic, or underline.
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Formatting Text and Paragraphs

Paragraph Formatting:

- Alignment: Left, Center, Right, Justify.

- Line Spacing: Adjust for readability.

- Lists:

- Create numbered or bulleted lists.
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Using Templates

Document Templates

- What Are Templates?

- Pre-designed layouts for resumes, reports,
letters, etc.
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Using Templates
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Using Templates

- How to Access Templates:

- File > New > Search templates.

- Customization:

- Replace placeholder text and adapt the design.
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Customizing the Ribbon

- Personalizing the Ribbon

- Steps to Customize:

1. File > Options > Customize Ribbon.

2. Add frequently used commands.

3. Save preferences for efficiency.

- Benefits: Streamline access to essential tools.
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Key Features for Productivity

- Productivity Features

- Spell Check: Highlights misspelled words (red
underline) and grammar issues (green underline).

- Page Numbers: Insert via Insert tab > Page
Number.
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Key Features for Productivity

- Headers and Footers: Add page titles, dates, or
page numbers for consistency.

- Keyboard Shortcuts: Save time (e.g., Ctrl+C,
Ctrl+V, Ctrl+X).
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Conclusion

- Microsoft Word is a powerful tool for creating
and managing text documents.

- Familiarity with basic features boosts
productivity.

- Customization options help streamline

workflows.
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END Of Lecture
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Topics Covered :

Overview of Advanced Word Processing Tools.

• Create Tables for structured data.

• Styles and Themes for consistent formatting.

• Tools for error-free writing.

• Headers and Footers for professional
document layout.
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Create Tables for structured data

- Tables offer a convenient way to display information
that might otherwise be confusing and cluttered.
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Create Tables for structured data

• To create a table in Microsoft Word, click on the
Insert ribbon.

• The Table button is the only one option on the Tables
group.
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Create Tables for structured data

1. Click on the Insert
ribbon, and then click
on the Table button.

2. The Table panel will
appear.

3. Select the rows and
columns needed.
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Create Tables for structured data

To insert a table onto your
document, move the
mouse pointer over the
number of rows and
columns you desire.
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Create Tables for structured data

4. The cell selection will
be highlighted as you
move the mouse.
When the desired
rows and columns are
highlighted, click on
the last cell.
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Create Tables for structured data

Enter Data in a Table:

Place the cursor in the cell where you wish to enter
the information. Begin typing

Note: The Table Tools tab only appears when a table
is selected.
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Modify the Tables Structure and 
Format a Table 

To modify the structure of a table:

 Click the table and notice that you have two new

tabs on the Ribbon: Design and Layout. These

pertain to the table design and layout.
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Modify the Tables Structure and 
Format a Table 

On the Design Tab, you can choose:

 Table Style Options

 Table Shading

 Borders Style

 Draw Borders
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Modify the Tables Structure and 
Format a Table 

To Format a table, click the table and then click the

Layout Tab on the Ribbon. This Layout Tab allows

you to:
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Modify the Tables Structure and 
Format a Table 

To Format a table, click the table and then click the

Layout Tab on the Ribbon. This Layout Tab allows

you to:
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Modify the Tables Structure and 
Format a Table 

 View Gridlines and Properties (from the Table

Group)

 Draw Table, Eraser (from the Draw Group)

 Delete the Table, Rows and/or Columns (from the

Rows & Columns Group)
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Modify the Tables Structure and 
Format a Table 

 Insert Rows and Columns (from the Rows &

Columns Groups)

 Merge or Split Cells (from the Merge Group)

 Increase and Decrease cell size (cell size Group)

 Align text within the cells and change text

directions (Alignment Group)
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Styles and Themes for consistent 
formatting

What Are Styles?

• Predefined sets of formatting for text (e.g., fonts,

sizes, colors).

• Examples: Headings, Normal text, Title, Subtitles.
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Styles and Themes for consistent 
formatting

How to Apply Styles:

• Navigate to the Home tab > Styles group > Choose

a style.

• Example: Apply "Heading 1" to a chapter title.
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Styles and Themes for consistent 
formatting

Modifying Styles:

• Right-click on a style > Modify to adjust font, size,
or alignment.

• Save changes for reuse.

Benefits:

• Maintains consistency across the document.

• Simplifies formatting for large documents.
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Styles and Themes for consistent 
formatting
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Themes for consistent formatting

Themes:

Before diving into how to use Microsoft Word
themes, it is important to understand what they are. A
theme in Word is a collection of design elements that
work together to create a consistent and polished
appearance throughout your document. It includes
font styles, font colors, paragraph spacing, heading
styles, and more.
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Themes for consistent formatting

Applying a Theme to a Document:

To apply a pre-designed theme to a document in
Microsoft Word, follow these steps:

1. Open the Word document you want to format.

2. Go to the "Design" tab on the ribbon.

3. In the "Document Formatting" group, click on the
"Themes" button.
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Themes for consistent formatting

Applying a Theme to a Document:

4. A drop-down menu will appear, showing a list of
built-in themes.

5. Select the desired theme by clicking on it.
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Themes for consistent formatting

Advantages:

1. Creates a professional look.

2. Ensures brand consistency
in business documents.
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Tools for error-free writing 
(Spell Check and Grammar Tools)

• Microsoft Word 2013 automatically
checks for incorrect spelling and
grammar.

• As you type in the document, Word
uses wavy red underlines to indicate
possible spelling errors and wavy
green underlines to indicate possible
grammatical errors.
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Tools for error-free writing 
(Spell Check and Grammar Tools)

• To correct an error, right-click on a word with a wavy
underline, and then click on the correction from the
option panel that you desire.

• You can also edit the error directly in the document if
no suggestions are applicable.



Page  25

Tools for error-free writing 
(Spell Check and Grammar Tools)

• Open the Editor pane to address issues by category.

1. On the Review tab, select Check Document.
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Tools for error-free writing 
(Spell Check and Grammar Tools)

2. The Editor pane categorizes spelling, grammar, and
stylistic issues.

3. Click each category to address the issues.
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Steps to enable Spell Checker in MS 
Word

1. On the navigation menu bar
click on the File option.

2. Next click on the options
button as shown in the
figure.

3. A word options dialog box
will appear on the screen.
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Steps to enable Spell Checker in MS 
Word

3. Now select the Proofing
option from the left
menu as shown in the
figure

4. Check all boxes as
shown in the figure
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Steps to enable Spell Checker in MS 
Word

6. Next click on the OK button. Finally, Spell Check is
enabled in MS Word
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Headers and Footers for professional 
document layout.

• Navigate to the Insert tab on the Ribbon.

• Click on "Header" or "Footer" to view a drop-down
menu of preset designs.

• Select a design that suits your needs. The chosen
header or footer will appear in your document, often
containing placeholders known as Content Control
fields.
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Headers and Footers for professional 
document layout.

• Click on these fields to input your specific
information, such as the document title or author's
name.
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Headers and Footers for professional 
document layout.

Adding Page Numbers:

1. With the header or footer section active, place the
cursor where you want the page number to appear.

2. Go to the Design tab and click on "Page Number."

3. Choose your preferred page number style and
position.
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Headers and Footers for professional 
document layout.

Inserting Date and Time:

1. While in the header or footer, position the cursor
where you want to add the date or time.

2. On the Design tab, click "Date & Time."

3. Select your desired format from the dialog box and
click "OK."
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Headers and Footers for professional 
document layout.

Removing Headers or Footers:

1. To delete a header or footer, double-click on the
respective area to activate it.

2. Delete the content within the header or footer.

3. Click "Close Header and Footer" or press Esc to
finalize the changes.
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Conclusion

This lecture covered advanced Word processing
features that can significantly enhance the functionality
and professionalism of your documents. Here's a recap:

1.Tables: You learned how to create, manage, and
format tables to organize data efficiently.
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Conclusion

2. Styles and Themes: These tools ensure consistency
and provide a cohesive design across your
document, saving time and effort in formatting.

3. Spell Check and Grammar Tools: These features
help ensure error-free, polished content by
identifying spelling and grammatical issues while
providing suggestions.
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Conclusion

4. Headers and Footers: By adding elements like page
numbers, dates, and titles, you can improve your
document's organization and appearance.
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END Of Lecture
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• Describe the purpose and utility of spreadsheets in

organizing and analyzing data.

• Explain the identification and usage of rows and columns,

highlighting their roles in structuring data.

• Define functions and formulas, emphasizing their roles in

calculations and data manipulation.

Objectives
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• Definition: A program for organizing, analyzing,

and storing data in rows and columns.

• Key Features: Data entry, calculations,

visualization, analysis tools.

• Examples: Microsoft Excel, Google Sheets,

LibreOffice Calc.

• Applications: Financial modeling, academic

analysis, inventory management, reporting.

Introduction to Spreadsheet Software
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INTRODUCTION TO SPREADSHEETS

Common user interface on all Office applications

• Menus and toolbars are similar to Word and Power Point

• Worksheet is an Excel spreadsheet

• Workbook contains one or more worksheets

• Toolbars--Standard and Formatting

• File menu--Save, Save As, Open and Print commands
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INTRODUCTION TO SPREADSHEETS

https://www.google.com/url?sa=i&url=https://www.theknowledgeacademy.com/blog/what-is-excel/&psig=AOvVaw0Ucle-_0dIciG4XI_N2Ycl&ust=1737955550235000&source=images&cd=vfe&opi=89978449&ved=0CBQQjRxqFwoTCLD-6ZrTkosDFQAAAAAdAAAAABAJ
https://www.google.com/url?sa=i&url=https://www.theknowledgeacademy.com/blog/what-is-excel/&psig=AOvVaw0Ucle-_0dIciG4XI_N2Ycl&ust=1737955550235000&source=images&cd=vfe&opi=89978449&ved=0CBQQjRxqFwoTCLD-6ZrTkosDFQAAAAAdAAAAABAJ
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OVERVIEW OF SPREADSHEET 
PROGRAMS
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o To work with a spreadsheet, you enter

data in the cells of the spreadsheet.

o You enter data by clicking a cell and

typing the data.

o To replace data in a cell, you click the

specific cell and type the new data.

o To edit data in a cell, you double click in

the cell and type additional data.

Note: when editing data, a blinking cursor
appears.

OVERVIEW OF SPREADSHEET 
PROGRAMS
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You can enter three types of data in a spreadsheet:

• Text: Text data has no numeric value associated with it.

• Numbers: A number has a constant numeric value.

• Formulas and functions: Formulas and functions are

mathematical equations.

WORKING IN A SPREADSHEET (CONT.)
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Cell Basics Cont.

Cells are the basic building blocks of a worksheet. You'll need to

learn the basics of cells and cell content to calculate, analyze, and

organize data in Excel.

Understanding cells

Every worksheet is made up of

thousands of rectangles, which are

called cells. A cell is the intersection of

a row and a column—in other words,

where a row and column meet.
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Understanding cells

Columns are identified by letters (A,

B, C), while rows are identified

by numbers (1, 2, 3). Each cell has

its own name—or cell address—

based on its column and row. In the

example below, the selected cell

intersects column C and row 5, so the

cell address is C5.

Cell Basics Cont.
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 Note that the cell address also appears in the Name box in the top-

left corner, and that a cell's column and row

headings are highlighted when the cell is selected.

 You can also select multiple cells at the same time. A

group of cells is known as a cell range. Rather than a

single cell address, you will refer to a cell range

using the cell addresses of the first and last cells in

the cell range, separated by a colon. For example, a

cell range that included cells A1, A2, A3,

A4,A5,A6,A7 and A8 would be written as A1:A8.

Take a look at the different cell ranges below

 Cell range A1:A8

Cell Basics Cont.
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Cell range A1:F1 Cell range A1:F8

Cell Basics Cont.
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To select a cell:

• To input or edit cell content, you'll first need

to select the cell.

1. Click a cell to select it. In our example, we'll

select cell D5.

2. A border will appear around the selected cell,

and the column heading and row heading will

be highlighted. The cell will remain selected

until you click another cell in the worksheet.

o You can also select cells using the arrow keys on your 

keyboard.

Cell Basics Cont.
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To select a cell range:

• Sometimes you may want to select a larger 

group of cells, or a cell range.

1. Click and drag the mouse until all of 

the adjoining cells you want to select 

are highlighted. In our example, we'll select 

the cell range A1:B11.

2. Release the mouse to select the desired cell 

range. The cells will remain selected until 

you click another cell in the worksheet.

Cell Basics Cont.
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To insert content:

1. Click a cell to select it. In our example, we'll 

select cell D6.

2. Type something into the selected cell, then

press Enter on your keyboard. The content will appear in

the cell and the formula bar. You can also input and edit

cell content in the formula bar.

Cell Basics Cont.
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To delete (or clear) cell content:

1. Select the cell(s) with content you want to delete. In 

our example, we'll select the cell range A6:D6.

2. Select the Clear command on the Home tab, then 

click Clear Contents.

3. The cell contents will be deleted.

 You can also use the Delete key on your keyboard to

delete content from multiple cells at once.

 The Backspace key will only delete content from one

cell at a time

Cell Basics Cont.
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 To delete cells:
• There is an important difference between deleting the

content of a cell and deleting the cell itself. If you

delete the entire cell, the cells below it will shift to fill

in the gaps and replace the deleted cells.

1. Select the cell(s) you want to delete. In our example, 

we'll select A6:D6.

2. Select the Delete command from the Home tab on 

the Ribbon.

3. The cells below will shift up and fill in the gaps.

Cell Basics Cont.
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To copy and paste cell content:

• Excel allows you to copy content that is already

entered into your spreadsheet and paste that

content to other cells, which can save you time

and effort.

1. Select the cell(s) you want 

to copy. In our example, 

we'll select D10.

2. Click the Copy command on the Home tab, or 

press Ctrl+C on your keyboard.

3. Select the cell(s) where you

want to paste the content. In our

example, we'll select D12:D16.

The copied cell(s) will have

a dashed box around them.

Cell Basics Cont.



Page  19

4. Click the Paste command on the Home tab, or 

press Ctrl+V on your keyboard.

5.The content will be pasted into the selected cells.

To use the fill handle:

• If you're copying cell content to adjacent cells in the same 

row or column, the fill handle is a good alternative to the 

copy and paste commands.

1. Select the cell(s) containing the content you want to use, then 

hover the mouse over the lower-right corner of the cell so 

the fill handle appears.
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2.Click and drag the fill handle until all of the cells 

you want to fill are selected. In our example, we'll 

select D11:D14.

3. Release the mouse to fill the selected cells.
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 To continue a series with the fill handle:

• The fill handle can also be used to continue a series.

Whenever the content of a row or column follows a

sequential order, like numbers (1, 2,

3) or days (Monday, Tuesday, Wednesday), the fill

handle can guess what should come next in the series.

In most cases, you will need to select multiple

cells before using the fill handle to help Excel

determine the series order

1. Select the cell range that contains the series you want to

continue. In our example, we'll select E1:E7.

2. Click and drag the fill handle to continue the series.

3. Release the mouse. If Excel

understood the series, it will be

continued in the selected cells.
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 To delete a row or column:

• It's easy to delete a row or column that you no longer need. 

In our example we'll delete a row, but you can delete a 

column the same way.

1. Select the row you want to delete. In our example, we'll 
select row 9.

2. Click the Delete command on the Home tab.

3. The selected row will be deleted, and those around it 

will shift. In our example, row 10 has moved up, so it's 

now row 9.
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• To INSERT a 
Row/Column: 

– Select the row/column 
heading, 

– Click the Home Tab,

– Click the Insert button 
from the Cells Group.

• The insertion occurs 
before the selected 
column/row.
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You can expand the width of a column

or the height of the row to increase the

visible space in each cell.

To begin changing the width of the

column, move the mouse pointer over

the right edge of column heading until

the mouse pointer changes to a double-

headed arrow.

You may want to organize or rearrange data in

your worksheet. To sort data in the worksheet,

click the column heading and then click Sort &

Filter in the Editing Group on the Home Tab.
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 Intro to Formulas

One of the most powerful features in Excel is the ability

to calculate numerical information using formulas. Just

like a calculator, Excel can add, subtract, multiply, and

divide.

 Mathematical operators

Excel uses standard operators for

formulas, such as a plus sign for

addition (+), a minus sign for

subtraction (-), an asterisk for

multiplication (*), a forward

slash for division (/), and

a caret (^) for exponents.

All formulas in Excel must begin with an equals sign (=). This 

is because the cell contains, or is equal to, the formula and the 

value it calculates.

 Understanding cell references

While you can create simple formulas in Excel using numbers

(for example, =2+2 or =5*5), most of the time you will use cell

addresses to create a formula. This is known as making a cell

reference. Using cell references will ensure that your formulas

are always accurate because you can change the value of

referenced cells without having to rewrite the formula
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• When you press Enter, the formula calculates and displays 

the answer in cell A3:

• In the formula below, cell A3 adds the values of cells A1 and 

A2 by making cell references:

• If the values in the referenced cells change, the formula 

automatically recalculates:

• By combining a mathematical operator with cell references,

you can create a variety of simple formulas in Excel.

Formulas can also include a combination of cell references

and numbers, as in the examples below:
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 To create a formula:

1. Select the cell that will contain the formula. In our example, 

we'll select cell D13.

2. Type the equals sign (=). Notice how it appears in both 

the cell and the formula bar.



Page  28

3.Type the cell address of the cell you want to reference first

in the formula: cell C9 A blue border will appear around the

referenced cell.

4. Type the mathematical operator you want to use. In our

example, we'll type the addition sign (+).

5. Type the cell address of the cell you want to reference

second in the formula: cell C10 in our example. A red

border will appear around the referenced cell

6. Press Enter on your keyboard. The formula will

be calculated, and the value will be displayed in the cell. If

you select the cell again, notice that the cell displays the

result, while the formula bar displays the formula

• If the result of a formula is too large to be displayed in a cell, it may

appear as pound signs (#######) instead of a value. This means the

column is not wide enough to display the cell content.

Simply increase the column width to show the cell content.
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Modifying values with cell references

The true advantage of cell references is that

they allow you to update data in your

worksheet without having to rewrite

formulas. In the example, we've modified the

value of cell C10 from 89 to 70. The formula

in D13 will automatically recalculate and

display the new value in cell D13.
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To create a formula using the point-and-click method:

Instead of typing cell addresses manually, you

can point and click the cells you want to include in

your formula. This method can save a lot of time

and effort when creating formulas. In our example

below, we'll create a formula to calculate the cost of

ordering several boxes of plastic silverware.

1. Select the cell that will contain the formula. In

our example, we'll select cell D12 and Type

the equals sign (=).
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2. Select the cell you want to reference first in the formula: 

cell D2 in our example. The cell address will appear in the 

formula.

3. Type the mathematical operator you want to use.

4. Select the cell you want to reference second in the formula: 

cell D3 in our example. The cell address will appear in the 

formula.
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Functions

 Function is a predefined formula that performs calculations

using specific values in a particular order. Excel includes many

common functions that can be used to quickly find

the sum, average, count, maximum value, and minimum

value for a range of cells. In order to use functions correctly, you'll

need to understand the different parts of a function and how to

create arguments to calculate values and cell references.
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Functions

 The parts of a function

In order to work correctly, a function must be

written a specific way, which is called

the syntax. The basic syntax for a function is

the equals sign (=), the function name (SUM,

for example), and one or more arguments.

Arguments contain the information you want to

calculate. The function in the example below

would add the values of the cell range A1:A20.
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Functions

Working with arguments

• Arguments can refer to both individual cells and cell

ranges and must be enclosed within parentheses. You

can include one argument or multiple arguments,

depending on the syntax required for the function.

• For example, the  

function =AVERAGE(B1:B9) would calculate 

the average of the values in the cell range B1:B9. 

This function contains only one argument.

 Creating a function

• SUM: This function adds all of the values of the cells 

in the argument.

• AVERAGE: This function determines the average of

the values included in the argument. It calculates the

sum of the cells and then divides that value by the

number of cells in the argument.

• COUNT: This function counts the number of cells

with numerical data in the argument. This function is

useful for quickly counting items in a cell range.

• MAX: This function determines the highest cell

value included in the argument.

• MIN: This function determines the lowest cell

value included in the argument.
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 To create a function using the AutoSum command:

• The AutoSum command allows you to automatically

insert the most common functions into your formula,

including SUM, AVERAGE, COUNT, MIN, and MAX.

In the example below, we'll use the SUM function to

calculate the total cost for a list of recently ordered

items

• In the Editing group on the Home tab, click

the arrow next to the AutoSum command. Next,

choose the desired function from the drop-down

menu. In our example, we'll select Sum

Functions
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• Select the desired function from the drop-down menu. In our

example, we'll select the Average function, which will count the

number of cells in the Items column that are not empty.

Functions



Page  37

• Select the desired function from the drop-

down menu. In our example, we'll select

the Average function, which will count the

number of cells in the Items column that

are not empty.

Functions
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END SESSION QUESTIONS

1.What is the scope of cells for A1:A10 in Microsoft Excel ?

2.Write steps to find the average of three cells (C1,C2 and C3)?

3.Explain by example the use of “if statement” in Microsoft Excel?

4. How it is possible to sort group of cells in Microsoft Excel?

5.Write steps to draw any style of chart in Microsoft Excel?

6.List five functions with their operations?
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Objectives

By the end of this lecture, students will be able to:

• Create a structured PowerPoint presentation.

• Apply formatting and design principles to

improve visual impact.
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INTRODUCTION

Microsoft PowerPoint is an electronic presentation

program that helps people present a speech using a

collection of slides. A PowerPoint presentation is a

collection of slides that can be used to create oral

presentations. By default, documents saved in

PowerPoint are saved with the .pptx extension whereas,

the file extension of the prior PowerPoint versions is

.ppt.
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Benefits of Power Point

PowerPoint provides multiple benefits to users,

including:

It is widely used, and considered the "standard" for

presentation software. If you create a PowerPoint

presentation, it's likely that anyone you want to share

it with will be able to open and view it, either with

PowerPoint or with a compatible application.
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Benefits of Power Point Cont.

It includes many optional presentation features,

including slide transitions, animations, layouts,

templates, and more.

It offers the option to export its slides to alternative

file formats, including GIF and JPG images, MPEG-4

video, PDF, RTF (rich text format), WMV (Windows

Media Video), and PowerPoint XML.



Microsoft PowerPoint

PowerPoint files are

called presentations.

Whenever you start a new

project in PowerPoint, you'll

need to create a new

presentation, which can

either be blank or from

a template.

• To create a new presentation:

1. Select the File tab to go to Backstage view.

2. Select New on the left side of the window, then 

click Blank Presentation.
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Slide Basics

 Every PowerPoint presentation is composed of a series of slides. To begin creating a slide show,

you'll need to know the basics of working with slides. You'll need to feel comfortable with tasks

like inserting a new slide, changing the layout of a slide, arranging existing slides, changing the

slide view, and adding notes to a slide.

 Understanding slides and slide layouts

• When you insert a new slide, it will usually

have placeholders to show you where content will be

placed. Slides have different layouts for placeholders,

depending on the type of information you want to include.

Whenever you create a new slide, you'll need to choose a

slide layout that fits your content.
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 Placeholders can contain different types of

content, including text, images, and videos.

Many placeholders have thumbnail

icons you can click to add specific types of

content. In the example below, the slide has

placeholdersfor the titleandcontent.

Slide Basics
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 To insert a new slide:

• Whenever you start a new presentation, it will

contain one slide with the Title Slide layout.

You can insert as many slides as you need from a

variety of layouts.

1. From the Home tab, click the bottom half of 

the New Slide command.

2. Choose the desired slide layout from the menu that appears.

Slide Basics
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3. The new slide will appear. Click

any placeholder and begin typing to add

text. You can also click an icon to add other

types of content, like a picture or chart.

 To change the layout of an existing slide, click

the Layout command, then choose the desired layout

Slide Basics
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To quickly add a slide that uses the same layout as the selected slide, click

the top half of the New Slide command.

Slide Basics
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Organizing Slides

PowerPoint presentations can contain as many slides as you need. The Slide

Navigation pane on the left side of the screen makes it easy

to organize your slides. From there, you can duplicate, rearrange,

and delete slides in your presentation.

Duplicate slides: If you want to copy and

paste a slide quickly, you can duplicate it. To

duplicate slides, select the slide you want

to duplicate, right-click the mouse, and

choose Duplicate Slide from the menu that

appears. You can also duplicate multiple

slides at once by selecting them first.

Page  12



 Move slides: It's easy to change the order of

your slides. Just click and drag the desired

slide in the Slide Navigation pane to the desired

position.

Delete slides: If you want to remove a

slide from your presentation, you

can delete it. Simply select the slide you

want to delete, then press

the Delete or Backspace key on your

keyboard.

Organizing Slides
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To copy and paste slides:

If you want to create several slides with the

same layout, you may find it easier to copy

and paste a slide you've already created

instead of starting with an empty slide.

1. Select the slide you want to copy

in the Slide Navigation pane, then

click the Copy command on

the Home tab. You can also

press Ctrl+C on your keyboard

Organizing Slides
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2. In the Slide Navigation pane, click just below a slide

(or between two slides) to choose a paste location.

A horizontal insertion point will appear.

3.Click the Paste command on the Home tab. You can also 

press Ctrl+V on your keyboard.

Organizing Slides
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Customizing slide layouts
 Sometimes you may find that a slide layout doesn't exactly fit your needs. For example, a layout might

have too many—or too few—placeholders. You might also want to change how the placeholders are

arranged on the slide. Fortunately, PowerPoint makes it easy to adjust slide layouts as needed.

 Adjusting placeholders

• To select a placeholder: Hover the mouse over the

edge of the placeholder and click (you may need to

click the text in the placeholder first to see the border).

A selected placeholder will have a solid line instead of

a dotted line.
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 To move a placeholder: Select the placeholder,

then click and drag it to the desired location.

• To resize a placeholder: Select the placeholder you want to

resize. Sizing handles will appear. Click and drag the sizing

handles until the placeholder is the desired size. You can use

the corner sizing handles to change the

placeholder's height and width at the same time.

•To delete a placeholder: Select the placeholder you want to 

delete, then press the Delete or Backspace key on your 

keyboard.

Customizing slide layouts
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 To add a text box:

• Text can be inserted into both placeholders and text

boxes. Inserting text boxes allows you to add to the

slide layout. Unlike placeholders, text boxes always stay

in the same place, even if you change the theme.

1. From the Insert tab, select the Text Box command.

2. Click and drag to draw the text box on the slide.

3. The text box will appear. To add text, simply click the text 

box and begin typing.

Customizing slide layouts
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 Using blank slides

• If you want even more control over your content, you may

prefer to use a blank slide, which contains no placeholders.

Blank slides can be customized by adding your own text

boxes, pictures, charts, and more.

• To insert a blank slide, click the bottom half of the New

Slide command, then choose Blank from the menu that 

appears.

 While blank slides offer more flexibility, keep in mind that

you won't be able to take advantage of the predesigned

layouts included in each theme.

Customizing slide layouts
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 To play the presentation:

• Once you've arranged your slides, you may

want to play your presentation. This is how

you will present your slide show to an

audience.

Click the Start From Beginning command on the Quick 

Access Toolbar to see your presentation.

1. The presentation will appear in full-screen mode.

2. You can advance to the next slide by clicking your mouse or

pressing the spacebar on your keyboard. You can also use

the arrow keys on your keyboard to move forward or backward

through the presentation.

3. Press the Esc key to exit presentation mode.

o You can also press the F5 key at the top of your keyboard to 

start a presentation.

Customizing slide layouts

Page  20



 To change the slide size:

• By default, all slides in PowerPoint 2013 use a 16-by-9—or widescreen—aspect ratio. You might know that

widescreen TVs also use the 16-by-9 aspect ratio. Widescreen slides will work best with widescreen monitors and

projectors. However, if you need your presentation to fit a 4-by-3 screen, it's easy to change the slide size to fit.

• To change the slide size, select the Design tab, then click the Slide

Size command. Choose the desired slide size from the menu that

appears, or click Custom Slide Size for more options.

Customizing slide layouts
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 To format the slide background:

• By default, all slides in your presentation use

a white background. It's easy to change the

background style for some or all of your slides.

Backgrounds can have a solid, gradient, pattern,

or picture fill.

1. Select the Design tab, then click

the Format Background command.

2. The Format Background pane will appear on the

right. Select the desired fill options. In our example, we'll

use a Solid fill with a light gold color.

3. The background style of the selected slide will update.

• If you want, you can click Apply to All to apply the same

background style to all slides in your presentation.

Customizing slide layouts
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Themes

A theme is a predefined combination of colors, fonts, and effects. Different themes

also use different slide layouts. You've already been using a theme, even if you

didn't know it: the default Office theme. You can choose from a variety of new

themes at any time, giving your entire presentation a consistent, professional look.

Each theme uses its own set of slide layouts. These layouts control the way your

content is arranged, so the effect can be dramatic. In the examples below, you can

see that the placeholders, fonts, and colors are different.
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 To apply a theme:

1. Select the Design tab on the Ribbon, then

click the More drop-down arrow to see all

of the available themes.

2. Select the desired theme.

3. The theme will be applied to your entire presentation.

Themes

o Once you've applied a theme, you can select a variant for 

the theme from the Variants group. Variants use different

theme colors while preserving a theme's overall look.
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Applying Transitions

 If you've ever seen a PowerPoint presentation that had special effects between each slide, you've seen slide

transitions. A transition can be as simple as fading to the next slide or as flashy as an eye-catching effect.

PowerPoint makes it easy to apply transitions to some or all of your slides, giving your presentation a

polished, professional look.

 There are three categories of unique transitions to choose from, all of which can be found on the Transitions tab.

1. Subtle: These are the most basic types of transitions. They use simple

animations to move between slides.
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2. Exciting: These use more complex animations to

transition between slides. While they're more visually

interesting than Subtle transitions, adding too many

can make your presentation look less professional.

However, when used in moderation they can add a

nice touch between important slides.

3. Dynamic Content: If you're transitioning between two slides

that use similar slide layouts, dynamic transitions will move

only the placeholders, not the slides themselves. When used

correctly, dynamic transitions can help unify your slides and

add a further level of polish to your presentation.

Applying Transitions
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 To apply a transition:

1. Select the desired slide from the Slide

Navigation pane. This is the slide that

will appear after the transition.

2. Click the Transitions tab, then locate

the Transition to This Slide group. By

default, None is applied to each slide.

3. Click the More drop-down arrow to display all transitions.

4.Click a transition to apply it to the selected slide. This will 

automatically preview the transition.

Applying Transitions
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 You can use the Apply To All command in

the Timing group to apply the same

transition to all slides in your presentation.

Keep in mind that this will modify any other

transitions you've applied.

 Try applying a few types of transitions to various

slides in your presentation. You may find that some

transitions work better than others, depending on

the content of your slides.

Applying Transitions

 To preview a transition:

You can preview the transition for a selected slide at 

any time using one of these two methods:

1. Click the Preview command on the Transitions tab.

2. Click the Play Animations command in the Slide 

Navigation pane.
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 Modifying transitions

You can quickly customize the look of a transition by 

changing its direction.

1. Select the slide with the transition you want to modify.

2. Click the Effect Options command and choose the

desired option. These options will vary depending on the

selected transition.

3. The transition will be modified, and a preview of the

transition will appear.

• Some transitions do not allow you to modify the 

direction.

Applying Transitions
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 To modify the transition duration:

1. Select the slide with the transition you want to

modify.

2. In the Duration field in the Timing group, enter

the desired time for the transition. In this example,

we'll decrease the time to half a second—or 00.50—

to make the transition faster.

 To add sound:

1. Select the slide with the transition you want to modify.

2.Click the Sound drop-down menu in the Timing group.

3.Click a sound to apply it to the selected slide, then preview 

the transition to hear the sound.

Applying Transitions
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 To remove a transition:

1. Select the slide with the transition you want to remove.

2.    Choose None from the Transition to This Slide group. 

The transition will be removed.

• To remove transitions from all slides, apply

the None transition to a slide, then click the Apply to

All command.

 Advancing slides

Normally, in Slide Show view you would advance to the

next slide by clicking your mouse or by pressing the

spacebar or arrow keys on your keyboard. The Advance

Slides setting in the Timing group allows the presentation

to advance on its own and display each slide for a specific

amount of time. This feature is especially useful

for unattended presentations, such as those at a trade

show booth.

Applying Transitions
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 To advance slides automatically:

1. Select the slide you want to modify.

2. Locate the Timing group on the Transitions tab.

Under Advance Slide, uncheck the box next to On

Mouse Click.

3.In the After field, enter the amount of time you want to

display the slide. In this example, we will advance the slide

automatically after 1 minute and 15 seconds, or 01:15:00

4. Select another slide and repeat the process until all slides

have the desired timing. You can also click the Apply to

All command to apply the same timing to all slides.

• If you need to advance to the next slide before an

automatic transition, you can always click the mouse or

press the spacebar to advance the slides as normal.
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End-Session Questions 

1. What is the default file extension for presentations created in PowerPoint?

2. Name three key benefits of using PowerPoint for presentations.

3. What is the purpose of placeholders in PowerPoint slides?

4. How can you insert a new slide with a specific layout?

5. Explain how to duplicate a slide in PowerPoint.

6. Describe the steps to move a slide to a different position in the Slide Navigation

pane.
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End-Session Questions 

7. What is the default file extension for presentations created in PowerPoint?

8. What is the difference between a text box and a placeholder?

9. What are the three categories of transitions in PowerPoint? Provide an example of each.

10. How can you preview a transition applied to a slide?
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Thank you
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